XML-Explained

extremely Maddening Language

Janell Craig, Oakland Schools and LeAnn Szymanski, Ottawa Area I1SD
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v/ Discussion 1:

* Introduce yourself (Name and District)

* Discuss one thing you know about XML
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v/ Discussion 2:

Introduce yourself (Name and District)

Discuss one thing you want to leave with here today
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Session Objectives

Learn XML files, and tools that can help safely and
accurately navigate editing XML

v Connector

v XML — What and Why

v/ XML Structures

v EXxercise

v XML Tools

v/ Questions
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What is XML

v EXtensible Markup Language

* |t is Extensible because it is not a fixed format
- HTML (webpage) is a fixed format; dedicated tags do specific
things... <font-color: blue> means just that

Extensible-designed to allow the addition of new capabilities and
functionality.

* Markup is the technical name for “marking” or tagging
(annotating) a document that indicates structure and layout
Instructions
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Why Use XML

v EXtensible Markup Language

* Purpose is to structure, store and transport data between
multiple applications and data uses

* Allows for Flexible Reporting

Defines specific (often nested) “tags” to create hierarchy

Is self-descriptive

Efficiently uses data across multiple applications
Allows for infinite number of reporting characteristics
Just needs to be “well formed”
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XML Structure and Example

¥Y<FallGeneralCollectionGroup xmlns:xsi="http://www.w3.org/2001/XMLSchema-instance” SchemaVersionMinor="1"
SubmittingSystemVersion="1.8" CollectionName="FallGeneralCollection" SubmittingSystemVendor="My System
Vendor" CollectionId="263" SchemaVersionMajor="2822-2623" SubmittingSystemiame="My System"
¥si:nolamespaceSchemalocation="https://cepi.state.mi.us/MSDSXML/MSD5/2022-2023/FallGeneralCollection2822-
20231 . xsd" >
v<FallGeneralCollection>
¥ <SubmittingEntity>
<SubmittingEntityTypeCode>D</SubmittingEntityTypelode>
<SubmittingEntityCode>33170</SubmittingEntityCode>
</SubmittingEntity>
¥ <{PersonalCore>
<UIC>B314140472</UIC>
<LastMName>Murray</LastName}>
<Firsthame>Perkins</FirstName>
<MiddleName>ANTHONY < /MiddleName>
£StudentSuffix>Sr.</StudentSuffix:
<DateQfBirth>2016-16-168</Date0ftBirth>
<MultipleBirthOrder»5</MultipleBirthOrder:
<Gender>M</Gender>
</PersonalCore>
¥ <SchoolDemographics>
<OperatingDistrictNumber>331768</0peratingDistrictNumber:
<SchoolFacilityNumber>@87828</SchoolFacilityNumber:
<StudentIdiumber>12578</StudentIdNumber:>
<GradelrSetting»14</GradelrSetting>
</SchoolDemographics>
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XML Structure

v MSDS XML Files are Hierarchical and formatted as:

e Header/Declaration statement

® Root Element (Parent)
® Components (Child)
® Elements (Sub-Child)

Elements are “nested”

* Elements are raw data values (Street Number, Street Name, City)
* Components contain related data elements (Address/Contacts)

* A Root Element is comprised of components
- Address, StudentDemographics, FTE, Special Education

e A Collection contains all Root Elements.
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XML Structure — Elements

v Values in elements are contained in “Tags”
v Tags are considered as either opening tags <Tag>
v Or closing tags </Tag>

v Data are visible between opening/closing tags. Example:

<name>Toast $2</name>

v Schema dictates allowed tags, values and sequence

v Consider Elements as “Sub-child”

—_——
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XML Structure — Components

-

v A component is a collection of related Elements, require
opening/closing tags and are dictated by schema

v The opening tag starts the component, followed by the
related elements, then the closing tag ends the
component

v Consider components as “Child” elements; Example:
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XML Structure — Root Element

v A Root element contains all related components and
elements (all child and sub-child elements)

y

v A Root element requires opening/closing tags and are
dictated by schema.

v The opening tag starts the Root Element, followed by the
related components, then the closing tag ends the Root

v/ Consider Root as “Parent” elements

v Everything in-between the open/close Root tags are
considered “Records”, then the pattern repeats

—_——
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XML Structure — Root Element
v Example:
<OnlineMenu> Root Opening Tag (Parent)
<lunchmenu> < Component Opening Tag (Child)
<name>Toast $2</name><+— Related Element (Sub-Child)
</lunchmenu> <« Component Closing Tag

</OnlineMenu> <« Root Closing Tag
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XML Structure - Declaration

v The declaration begins the XML file; let’s call this the
“header”

v The header can include file identification, version ID,
processing instructions and schema references

v The header may look different from file to file
depending on the schema

v/ A Schema is a Document that contains Rules for the
xml file

v Schemas define rules for a file’s structure & content
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XML Structure - Declaration

v The header can look as simple as

<Collection ID ?xml Version="1.0">

v The Header can also be more complex as the headers
we see in MSDS XML Files

* Note beginning opening tag <FallGeneralCollectionGroup....>

¥<FallGeneralCollectionGroup xmlns:xsi="http://www.w3.0rg/2081/XMLSchema-instance” SchemaVersionMinor="1"
SubmittingSystemVersion="1.8" CollectionName="FallGeneralCollection" SubmittingSystemVendor="My System
Vendor" CollectionId="263" SchemaVersionMajor="2022-2823" SubmittingSystemhame="My System"
¥si:nolamespaceSchemalocation="https://cepli.state.mi.us/MSDSXML/MSDS/2022-2023/FallGeneralCollection2822
JP231 wod">

¥<FallGeneralCollection>
¥<SubmittingEntity>
<SubmittingEntityTypelode>D</SubmittingEntityTypeCode>
<SubmittingEntityCode>33170</SubmittingEntityCode>
</SubmittingEntity>
¥ <PersonalCore>
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XML Structure — Recap

v XML files begin with the declaration statement (header)

vkFallGeneralcallectiunGroup:xmlnz:x5i:"http:ffwww.wB.0ng2@@1fIMLSchema—instance" SchemaVersionMinor="1"
EubmittingSysﬁemVersionz”1.é" CollectionName="FallGeneralCollection" SubmittingSystemVendor="My System
Vendor" CollectionId="263" SchemaVersionMajor="2022-20823" SubmittingSystemName="My System"
xsi:noNamespaceSchemalocation="https://cepi.state.mi.us/MSDSXML,/MSDS/2022-2023/FallGeneralCollection2@22
26231 =g
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XML Structure — Recap

v After the declaration (header), the next tag is the Root

(parent) tag

xsi:noNamespaceSchemalocation="https://cepi.state.mi.us/MSDSX

20231 .xsd" >

Y<FallGeneralCollection) i ———

¥<SubmittingEntity>

<SubmittingEntityTypeCode>D</SubmittingEntityTypelode>
<SubmittingEntityCode>33170</SubmittingEntityCode>

</SubmittingEntity>
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XML Structure — Recap

¥<FallGeneralCollection>
V<SubmittingEntity > lf—
£SubmittingEntityTypeCode>D</SubmittingEntityTypeCode>
£SubmittingEntityCode>»33170</SubmittingEntityCode>
</SubmittingEntity>
¥ <PersonalCore: i———
<UIC>8314148472</UIC>
<LastName>Murray</LastName>
<FirstName>Perkins</FirstName>
<MiddleName>ANTHONY< /MiddleName>
{StudentSuftix>Sr.</StudentSuffix>
<Date0fBirth>2016-18-10</Date0fBirth>
<MultipleBirthOrder>5</MultipleBirthOrder:
<Gender>M</Gender>
{/PersonalCore>
¥ <SchoolDemographics > ilf———
{0OperatingDistrictNumber>33170</0peratingDistrictNumber:
<SchoolFacilityNumber>@7828</SchoolFacilityNumber:
<StudentIdNumber>12578</5tudentIdNumber>
<GradeQrSetting>»14</GradelOrSetting>
</SchoolDemographics>

-

v Within the Root (parent) tags, are components (child)
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XML Structure — Recap

v Within Components (child) tags, are elements (sub-child)
v Elements contain data values for the record; Example

¥ <FallGeneralCollection>
¥ <SubmittingEntity>
£SubmittingEntityTypeCode>D</SubmittingEntityTypeCode>
<SubmittingEntityCode>33170</SubmittingEntityCode>
</SubmittingEntity>
¥<PersonalCore>
<UIC>8314140472</UIC>
£LastMame>Murray</LastName>
<FirstName>Perkins</FirstName>»
<MiddleName>ANTHONY< /Midd]leName>
<StudentSufftix>Sr.</StudentSuffix:
<Date0fBirth>2016-18-16</Date0fBirth>
{MultipleBirthOrder>5</MultipleBirthOrder:>
<Gender>M</Gender>
</PersonalCore>
¥ <5choolDemographics>
<OperatingDistrictNumber>33170</0OperatingDistrictNumber:>
<SchoolFacilityNumber>87828</SchoolFacilityNumber:>
<StudentIdlumber»12578</StudentIdilumber>
<GradeOrSetting>14</GradeOrSetting>
</SchoolDemographics>
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XML Structure — Recap

v Remember... Note beginning opening tag in header
<FallGeneralCollectionGroup....>

¥<FallGeneralCollectionGroup xmlns:xsi="http://www.w3.org/2601/XMLSchema-instance"” SchemaVersionMinor="1
SubmittingSystemVersion="1.8" CollectionMame="FallGeneralCollection" SubmittingSystemVendor="My System
Vendor" CollectionId="263" SchemaVersionMajor="2022-2023" SubmittingSystemName="My System"
¥si:rnoMamespaceSchemalocation="https://cepi.state.mi.us/MSDSXML/MSDS/2822-2023/FallGeneralCollection2822
20231 xed">
¥<FallGeneralCollection>
¥<SubmittingEntity>
<SubmittingEntityTypelode>D</SubmittingEntityTypeCodes>
<SubmittingEntityCode>331760</SubmittingEntityCode>
</SubmittingEntity>
¥ <PersonalCore>

v At end of file, after last Root Closing tag, note collection
closing tag </FallGeneralCollectionGroup>

v<EarlyOnServices>
<ServiceCode>8B8</Servicelode>
{LengthInMinutes>317332</LengthInMinutes>
{Frequency0fService>»235</Frequency0fService>
</EarlyOnServices>
</FallGeneralCollection>

fi;"FallGEneraltcllectiﬂnﬁroup)“—_
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XML Structure — Recap

v XML File is complete

——— ——— —
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XML Exercise

v SEE HAND-OUT...

v Using the information provided in our discussion thus
far, write a properly formed XML document using the
Information given

v This resulting XML should contain a properly formatted
menu listing breakfast, lunch and dinner items

v/ 10 Minutes...

- - -y, ™
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XML Exercise

1 <onlinemenu>

2 <lunchmenu>

3 </breakfastmenu>

4 <name>Chicken $10</name>

5 <name>Toast $2</name>

6 <dinnermenu>

7 <breakfastmenu>

8 <Collection ID ?xml Version="1.0">

9 <description>With Rice</description>
10 </dinnermenu>

11 <name>Soup $5</name>

12 </lunchmenu>

13 <description>Cream Soup</description>
14 <description> Wheat or White</description>
15 </onlinemenu>

e ————————————————————————————
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14

11
13
12

10
15

<Collection ID ?xml Version="1.0">
<onlinemenu>
<breakfastmenu>
<name>Toast $2</name>
<description> Wheat or White</description>
</breakfastmenu>
<lunchmenu>
<name>Soup $5</name>
<description>Cream Soup</description>
</lunchmenu>
<dinnermenu>
<name>Chicken $10</name>
<description>With Rice</description>
</dinnermenu>

</onlinemenu>
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XML Tools
v CEP| MSDS Website

¢ MSDS Collection Detalls Manual

¢ Technical Materials = Download Sechema Reference

R — IR _—_—_—_—
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XML Tools

v Component Matrix
* Sheet Tab (List of Values) Lists errors received in MSDS
Validation

e Search XML for related error item

—_—
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XML Tools

v NotePad or WordPad

* Exposes raw XML file for review and change
* Doesn’t format data “pretty”

| xml example.txt - Notepad

File Edit Format View Help

<?xml version="1.@" encoding="utf-8"?>

<EarlyRosterGroup SchemaversionMinor="1" SubmittingSystemVersion="1.8" CollectionName="EarlyRoster" SubmittingSystemvend:
<EarlyRoster>
<SubmittingEntity><SubmittingEntityTypeCode>D</SubmittingEntityTypeCode><SubmittingEntityCode>63000</SubmittingEntitycCod:
<PersonalCore><UIC>0000000000</UIC><LastName>SMITH</LastName><FirstName>John</FirstName><DateOfBirth>2000-11-06</Date0fB
<SchoolDemographics><OperatingDistrictNumber>63000</0peratingDistrictNumber><SchoolFacilityNumber>e@8e</SchoolFacilityNu
<PersonalDemographics><ResidentLEANumber>63000</ResidentLEANumber><StudentResidentCounty>63</StudentResidentCounty><Ethn
<Contacts><AddressTypeDescriptor>Physical</AddressTypeDescriptor><StreetNumbernName>29000 Smith Avenue</StreetNumbername>-
</EarlyRoster>

<EarlyRoster>
<SubmittingEntity><SubmittingEntityTypeCode>D</SubmittingEntityTypeCode><SubmittingEntityCode>63000</SubmittingEntitycCod:
<PersonalCore><UIC>0000000000</UIC><LastName>Button</LastName><FirstName>Jane</FirstName><MiddleName>Su</MiddleName><Dat:
<SchoolDemographics»><OperatingDistrictNumber>63000</0peratingDistrictNumber><SchoolFacilityNumber>@ee0e</SchoolFacilityn
<PersonalDemographics><ResidentLEANumber>63140</ResidentLEANumber><StudentResidentCounty>63</StudentResidentCounty><Ethn
<Contacts>»<AddressTypeDescriptor>Physical</AddressTypeDescriptor><streetNumberName>53 E Avenue</StreetNumberName><City>Al
</EarlyRoster>

<EarlyRoster>
<SubmittingEntity><SubmittingEntityTypeCode>D</SubmittingEntityTypeCode><SubmittingEntityCode>63000</SubmittingEntitycCod:
<PersonalCore><UIC>0000000000</UIC><LastName>Smith</LastName><FirstName>Jane</FirstName><MiddleName>Joseph</MiddleName><I
<SchoolDemographics»><OperatingDistrictNumber>63000</0peratingDistrictNumber><SchoolFacilityNumber>@ee0e</SchoolFacilityn
<PersonalDemographics><ResidentLEANumber>63000</ResidentLEANumber><StudentResidentCounty>63</StudentResidentCounty><Ethn:
<Contacts>»<AddressTypeDescriptor>Physical</AddressTypeDescriptor><streetNumberName>112@ Avenue</StreetNumberName><City>A
</EarlyRoster>

</EarlyRosterGroup>
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Microsoft XML Notepad

For Windows users
Exposes raw XML file for review

Allows for xml editing
Compare tool at View>Compare XML Files

MPAAA Conference Fall 2023
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Microsoft XML Notepad Compare Tool
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XML Tools

v NotePad++

Exposes raw XML file for review

Can set to pretty-print (Plugins>XML tools)
Can use compare tools (Plugins>Compare)
Allows for xml editing

Free-ware

_ —
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XML Tools

v NotePad++
* Compare Tools (Plugins>=Compare)

—————————————————— —— e —— e ———————
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XML Tools

v Fee Based XML Editors (too many to list - $3$)
* In this example, Altova XML Spy allows validation, editing

R — IR _—_—_—_—
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XML Tools

v Excel (older versions) — Open As Table — imports all

* Data Are displayed in row/column format

R — ST iiDEmEmm————_—_—____—_—__
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XML Tools

v Newer Version of Excel - Developer=Import
e Ensure developer menu options is available
e Right click on ribbon - click Customize the Ribbon

e Click “Developer” to enable

[ view
Developer

[v|Help
[l Acrobat -

MNew Tab New Group Rename...

R E— R ———— O — —
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XML Tools

v Newer Version of Excel - Open As Table

v Developer>Import

e Developer>Import

e Select OK

Import Data ? >

Where do you want to [:@'tthe data?
@} XML table in existing worksheet:

sas|

() XML table in new worksheet

| Properties... | | oK | | Cancel |

MPAAA Conference Fall 2023
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v Excel — Open with Source Pane

o Need to ensure “Rules” are in place
before we start

o Ensure collection schema is
downloaded from CEPI website

o Click Developer>Source (opens XML
Source Pane)

o Click XML Maps
Click “Add” to navigate to saved
schema location, then OK

O Fields available in Collection are made
available in the XML source Pane

- <z

XML Tools

o .

» -
‘ ’
XML Source R
XML maps in this workbook:
‘ GeneralTeacherStudentDatalinkGroup_Map v
=& GeneralTeacherStudentDataLlinkGroup ~

----- = SchemaVersionMajor

----- ] SchemaVersionMinor

----- &= Collectionld

----- 1 CollectionName

----- = SubmittingSystemVendor

----- = SubmittingSystemName

----- =] SubmittingSystemVersion

B@ GeneralTeacherStudentDatalink
=+ SubmittingEntity

----- = SubmittingEntityTypeCode

----- =] SubmittingEntityCode

=+ PersonalCore

----- = LastName
----- = FirstName
----- = MiddleName
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XML Tools

v Excel — Open with Source Pane
* Rules are loaded, time to import
* Highlight fields to review
* Click and Drag fields from source pane to spreadsheet
* Click Import; select XML file to import

— N —
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XML Tools

v/ Excel — Open with Source Pane
Highlighted fields are imported for review and DQ

y A D F G H | J
1

2 (0000000001 Smith June A 10/14/1999 M 55555 ~
3 (0000000002 Jones John A 5/29/2003 M 55555 "12
4 0000000003 Doe Sue A 6/25/2004 M 55555 "12
5 (0000000004 Smith Betty A 8/29/1999 F 55555 "4
6 0000000005 Jones June A 10/5/2003 M 55555 "12
7 [0000000006 Doe John A 6/7/2004 M ’s5555 "12
8 0000000007 Smith Sue A 12/25/2002 F 's5555 "12
9 (0000000008 Jones Betty A 10/6/2003 M ’s5555 "12
10 0000000009 Doe June A 8/8/2003 M '55555 12
11 (0000000010 Smith John A 1/1/2004 F '02034 "12
—_— — L =S -
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XML Tools

v Ablebits Program

e Tool that will merge duplicates in an XML file to one
row of data in Excel

e Contains other valuable tools for Excel and Google
Sheets (Vlookup wizard, Date & Time wizard,
Duplicate Remover, etc.)

e Options from $70-$300, one time fee

https.//www.ablebits.com/
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v Now that everyone has Xcellent Mad SkilLlz...
* Final thoughts?

* Questions?

©
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